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Chapter 3:  Using SEER*DMS 
SEER*DMS uses an HTML-based interface displayed via a Web browser.  Mozilla Firefox (version 
3.0 or later) is the only browser currently supported.  Reports generated by SEER*DMS are 
designed to be viewed and printed as PDF files.  Adobe Reader is required to view or print reports 
(version 7.0 or later is recommended). 

In this chapter, you’ll learn about 

• Logging into SEER*DMS 

• Changing Your Password 

• Using the Home Page 

• Worklist Summary 

• SEER*DMS Menus 

• Keyboard Shortcuts 

• SEER*DMS Dos and Don’ts 

• Page and Calendar Tools 

• Setting Account Preferences 

• News Items 

• Automatic Logoff Due to Inactivity 

• Viewing More Information on Your Screen  

• Viewing Two Screens at Once  

• Searching for Text 

• Browser Navigation Settings 

• Display Recommendations 

• Recommended Firefox Options 

• Using the SEER*DMS Test Server  

Logging into SEER*DMS 

To access SEER*DMS, direct your web browser to the address provided by your registry’s system 
administrators.  In most cases, a shortcut will be available on your desktop.  A system 
administrator must set up a SEER*DMS account for each new system user.  Once your account is 
created, a username and randomly generated password will be e-mailed to you.  (When the system 
is first installed at your registry, usernames and passwords will be assigned and provided to you 
during training.)   

 

 
When you access SEER*DMS, the Login page will 
be displayed as shown here.  Note:  The colors 
used in SEER*DMS are determined by the Color 
Scheme selected in your Account settings. 
 
Enter your Username and Password.  Click 
Login. 

 

 



3-2 1/14/2009        SEER*DMS User Manual  

If this is your first login or your password was reset, change your password.  Do not continue to 
use a password that was assigned to you or sent via e-mail.  Please refer to the Changing Your 
Password section of this chapter. 

 If your login attempt is unsuccessful: 

• User names and passwords are case sensitive.  Make certain Caps Lock is turned off. 

• Contact your supervisor to determine whether your account has been deactivated, or if you 
are subject to a login restriction. 

• If you have forgotten your password, contact a system administrator to reset your 
password.  A new, randomly generated password will be e-mailed to you.  You should 
immediately log in and change your password to something you will remember. 

Login restrictions: 

• If you are unable to log in to SEER*DMS, your account may be subject to a Business 
Hours Restriction.  This restriction blocks access to the system outside of the registry’s 
standard hours of operation.  Your registry’s system administrators have the ability to 
specify the standard business hours in the system configuration settings.  

It is strongly recommended that you log off SEER*DMS when you are not using the system.  If you 
do not log off, confidential data may be displayed on your monitor or be accessible from your 
computer.  Save your current work, if necessary.  To log off, click the Logoff link which appears in 
the top right corner of each page.  Your session will be ended and the Login page will be displayed. 

Changing Your Password 

When logging in for the first time or when your password is reset, you should change your assigned 
or randomly generated password to a secure password that is easy for you to remember.   

SEER*DMS provides access to confidential data.  It is your responsibility to protect and maintain 
your password according to registry policy.  If you forget your password, a system administrator 
can reset it.  Your password will be set to a random string and you will be notified of the change via 
e-mail.  Log in with the new password and immediately change your password. 

To change your password: 

1. Click the Account link in the User Bar at the top right corner of the page. 

2. Enter your Old Password. 

3. Enter a New Password.  All passwords must be at least six characters in length.  Security 
measures to protect the confidentiality of patient data must include the use of strong 
system passwords.  Your password should: 

a. Include symbols, digits, and letters of both upper and lower case.  You should use at 
least one symbol or character in a position other than the first or last character. 

b. Be significantly different from passwords that you have used in the past. 

c. Not include your name, your username, your child’s name, or your pet’s name. 

d. Not be a common word or name.  

4. Re-enter your new password in the Verify Password field. 

5. Click Save.  Your new password will be effective immediately. 



Using SEER*DMS    1/14/2009 3-3 

Using the Home Page 

Each time you log in to SEER*DMS, you will start at your personalized Home page.  This page is 
your gateway to the specialized tools and features in the system.   At any time, you can return to 
the home page by clicking the SEER*DMS logo in the banner or selecting View > Home. 

 

• A summary of the worklist is displayed on the left side of the home page.  The links and 
counts are described in the Worklist Summary section of this chapter. 

• The Latest News section displays News items posted by registry staff. 

• The version of the SEER*DMS software is displayed at the bottom of every SEER*DMS 
screen.  The date and time of the build are displayed in parentheses. 

• The SEER*DMS Logo, User Bar, and Toolbar appear at the top of every page in the 
system.   

o Click the SEER*DMS Logo to return to the home page from any page in the system.   

o The User Bar includes your user name, access to your Account Preferences, and the 
Logoff link.  If you have a system permission to view or edit patient data, it will also 
include the “Lookup” search box.  Please refer to Chapter 20:  Searching for Records 
and Patients for information about the toolbar quick search and other searching 
techniques. 

o The name of the current page is displayed in the left side of the Toolbar.  The 
Toolbar also includes menus that provide access to all pages and features in the 
system (see the SEER*DMS Menus section of this chapter). 

o To avoid the loss of effort when using these features, follow the guidelines specified 
in the SEER*DMS Dos and Don’ts section of this chapter. 

Worklist Summary 

 

A personalized worklist summary is displayed on the left 
side of the home page.  My Tasks summarizes the tasks 
assigned to you and provides shortcut links to those tasks.  
Click Worklist to view a list of all tasks assigned to you.  
Click one of the task types in My Tasks to view tasks of 
that type that are assigned to you. 

The number of tasks currently assigned to you is displayed 
to the left of the task type.  For example, in the sample 
shown on the left, two Consolidate tasks are assigned to the 
user.  Clicking on the Consolidate link in this sample will 
bring up a filtered Worklist showing the two Consolidate 
tasks which are currently assigned to this user. 
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The Unassigned Tasks list on the Home page summarizes 
the unassigned tasks that you are permitted to access, and 
provides shortcut links for each type of task.  The number 
of tasks per type is displayed to the left of each link.     

Clicking on the Resolve Record Errors link in this sample 
will bring up a filtered Worklist that displays the 22 
unassigned Resolve Record Errors tasks. 

 

SEER*DMS Menus 

A Toolbar is displayed on every page in SEER*DMS. 

 

The name of the current page is always displayed on the left of the toolbar.  On the right, the 
toolbar displays pull-down menus to access various features of the SEER*DMS system.  Some 
menu items are only displayed if the user has the system permission associated with the menu 
item.  A full list of menu options is shown below. 

• View 

o Home 
o Worklist (Chapter 4: Using the Worklist) 
o Patients (Chapter 20:  Searching for Records and Patients) 
o Contacts (Chapter 19: Maintaining the Contact List) 
o Facilities (Chapter 18: Maintaining the Facility List) 
o Reports (Chapter 24: Creating Reports and Extracting Data) 

• Manage 

o Abstract Facility Leads (Chapter 21: Managing Abstracting Assignments) 
o Active Follow-up (Chapter 16:  Follow-up) 
o Follow-back (Chapter 22: Follow-back) 
o Special Studies (Chapter 28: Special Studies) 

• System 

o Staff (Chapter 25: Managing User Accounts) 
o Roles (Chapter 26: System Roles) 
o Import (Chapter 5: Importing Data Files and Chapter 6: Data Entry) 
o Tasks (Chapter 27: System Administration) 
o Edits (Chapter 7: Edit Errors) 
o Administration (Chapter 27: System Administration) 

• Help 

o User Manual 
o Registry-defined configuration settings and algorithms 
o Version History 
o Support (Technical Support section of Chapter 27: System Administration) 
o About SEER*DMS 
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Keyboard Shortcuts 

 

 
SEER*DMS supports keyboard shortcuts for many of the 
menu items and for specific actions in the Record and 
Patient Set editor.    
 
At any time, you may press Ctrl+Alt+H to view the list of 
keyboard shortcuts shown here.  The keyboard shortcuts 
for menu items are also listed in the menus.   
 
 
 
 

SEER*DMS Dos and Don’ts 

Since SEER*DMS is a Web-based system, you will modify data and access features on system 
“pages”.  You must use the page buttons to exit pages that enable you to make modifications to 
patient or system data.  These buttons include “Save & Exit”, “OK”, “Close”, and “Cancel”.  If you 
click User Bar links, Toolbar menus, or use keyboard shortcuts to leave the editor, changes made 
will not be saved.  Likewise, if you exit an editor by using your browser’s navigation controls, 
unsaved changes will not be saved.  This may be a new concept for some users.  If you use the 
Internet, you have probably become accustomed to this behavior.  For example, if you are 
purchasing airline tickets on an Internet site but change your mind before clicking “Buy”, going to 
another Web site will void the incomplete transaction.  

Do 

• Use the links, buttons, and menus located in the body of the page to complete the current 
task.  If you have made changes that must be saved, do not use the navigation in the 
SEER*DMS logo, User Bar, or Toolbar to exit a page.  

• Click the SEER logo to return to the home page, but only if you saved any changes made on 
the current page or do not wish to save them. 

• Use the User Bar links and Toolbar menus to access system features, but only if you have 
already saved changes made on the current page or do not wish to save them. 

Don’t 

• Don’t use any browser controls to navigate.  Never use the Back button, Forward button, or 
enter a URL in the address box.  The Setting Browser Preferences section of this chapter 
provides more information about the browser controls to avoid; and methods for hiding 
navigation features that you should not use.   



3-6 1/14/2009        SEER*DMS User Manual  

• Don’t use the backspace key unless you are editing a field.  In a browser application, 
backspace is a shortcut for the browser’s Back button. 

• Don’t use the links or menus in the User Bar or Toolbar when you have made changes that 
must be saved.  (Help > User Manual is the exception to this rule.  The SEER*DMS Help 
System opens in a separate window, your work will be unchanged and will continue to be 
displayed in the original window.) 

• Don’t click the SEER*DMS logo to return to the home page when you have made changes 
that must be saved.  
 

Note:  SEER*DMS is a Web-based application that is maintained on a server located within the 
registry.  The system is not connected to the Internet.  Access to the system from remote locations 
is controlled by a firewall configuration designed, installed, and maintained by registry IT staff. 

Page and Calendar Tools 

The lists in SEER*DMS, such as the Worklist, often contain too many results to fit on the screen all 
at once.  In these cases, the list will be broken into several pages.  Use the Page Selection links 
displayed at the top or bottom of the list to navigate the list, as in the example below. 

 

Click Prev or Next to advance one page back or forward.  Click First or Last to move to the 
beginning or end of the entire list.  Click an individual page number to jump to a specific page.  A 
maximum of eight page numbers will be displayed; there may be additional pages that are not 
listed.  Additional page numbers will be displayed when you click the eighth page in the current set.   

The calendar tool can be used to enter a correctly formatted date in the field adjacent to a calendar 

icon:  

Click on the icon to bring up a calendar of the current month.  The calendar will open with the 
current date highlighted, as shown below. 

 
 
To browse by month, use the < and > buttons at the top of the calendar.  Use the << and >> 
buttons to browse by year.  Use the mouse to click a specific date.  This date will be automatically 
formatted and displayed in the adjacent date field. 

To close the calendar without selecting a date, click the x button in the upper right corner. 
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Setting Account Preferences 

To modify your account information: 

Click the Account link in the User Bar at the top right corner of the page.  First Name, Last 
Name, and E-mail address fields are required fields and cannot be blank.  Your username is set 
when your account was created and cannot be modified. 

There are four Color Schemes available in SEER*DMS.   Once you select a color scheme you must 
click save to apply the change.   

To change your password: 

a. Enter your Old Password. 

b. Enter a New Password.  All passwords must be at least six characters in length. 

c. Re-enter your new password in the Verify Password field. 

d. Click Save. 

News Items 

System permissions:  news_add, news_edit, news_delete 

The Latest News list displays messages in the order in which they are added, with the most 
recent item appearing at the top of the page.  All SEER*DMS users can view the news list, but 
system permissions are required to add, edit, or delete news. 

To add or edit a News Item: 

1. Select the add item link at the top of the Latest News list; or click the edit link displayed 
below an existing news item’s title bar. 

2. Enter a Title for your news item.  This field can hold a maximum of 100 characters. 

3. Enter the text of your message in the Body field.  You may enter up to 4000 characters in a 
news item.  You may use the formatting controls to embed links, specify font, font size, 
color, highlighting, bulleting, numbered lists, and other features in the news text. 

4. Click Save.  Your message will appear at the top of the news list. 

To delete a News Item: 

1. Click the Delete link displayed below the news item’s title bar. 

2. SEER*DMS will query you to confirm that you really want to delete the item.  Click OK to 
delete the item or click Cancel to return to the Home page. 

To send an email to the author of a news item: 

1. Click the Author’s Name displayed below the news item's title bar. 

2. SEER*DMS will open your email client software and create a blank message addressed to 
the author of the news item.  Complete and send the email message. 
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Automatic Logoff Due to Inactivity 

SEER*DMS will automatically end your session and log you off after a long period of inactivity.  The 
last screen that you viewed will continue to be displayed on your monitor and may include 
confidential patient data.  Therefore, it is strongly recommended that you use the logoff link to end 
your session when not using the system.   

The system is initially configured to end your session after two hours of inactivity; however, the 
length of time can be changed per request of registry management.  (It is recommended that this 
time period not be set to a value less than one hour, to avoid the loss of unsaved work.)  

Note: Moving the mouse and entering text do not constitute activity between the browser and the 
SEER*DMS server.  Until you click a button, link, or   lookup to perform an action or access 
another page, your session will be considered inactive. 

After automatic logoff, any open SEER*DMS pages will continue to be displayed as long as your 
browser is open.  If you click on any button or link in the SEER*DMS window, the system will 
attempt to restore your session after prompting you for your username and password.  However, 
any unsaved changes to a record or patient set may be lost. 

Viewing More Information on Your Screen 

The data pages in SEER*DMS often contain too many data items to display on your monitor 
without scrolling.  If you would like to view more information on your screen at one time, you may 
want to consider the following: 

• Firefox has a “Full Screen” feature that enables you to hide toolbars and controls that use 
valuable screen real estate.  Press F11 to view SEER*DMS in full screen.  Your Windows 
taskbar and browser menu will be hidden, and a larger number of data fields will be 
displayed.  Press F11 again to restore the Windows taskbar and browser menu.  

• Monitors commonly use a landscape orientation.  However, many flat LCD monitors can be 
pivoted to portrait orientation.   If you view data pages in portrait orientation, a 
substantially larger number of fields will be displayed without scrolling. 

• SEER*DMS requires a minimum resolution of 1024x768.  However, a higher resolution is 
recommended if possible.  SEER*DMS auto-detects the resolution.  If the resolution is 1600 
or greater in width, a second panel of data will be shown on the right side of the Record and 
Patient Set editors.  You may view text or a list of failing edits while viewing other data in 
the left part of the screen.  If the resolution is less than 1600 in width, the user will need to 
open the text in a separate window and view edits on a separate page.  Using a resolution 
greater than the minimum will also reduce the scrolling while editing. 

Viewing Two Screens at Once 

SEER*DMS supports the viewing of two pages during a single session.  The second page will open 
in either a new Window or Tab, depending on your Firefox option settings.  If you are using a single 
monitor, it is recommended that you set Firefox to open new pages in a new tab within a single 
Window (multiple Windows may be hidden on a single monitor).  If you are using dual monitors, it 
is recommended that you set Firefox to open new pages in a new Window and move the newly 
opened Window to the other monitor.   

To open a second SEER*DMS page: 

1. “Middle-click” a link or menu item in SEER*DMS.   To “Middle-click”, you may either click 
your mouse wheel or press CTRL as you click.   The page will open as a new tab or new 
Window depending on the settings in your Firefox options. 
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2. Or right-click a menu item or link in SEER*DMS.  A menu will be displayed.  Select Open 
Link in New Window or Open Link in New Tab. 

To set the default method used by Firefox to open new pages: 

1. From the Firefox Tools menu, select Options.  

2. Click the Tabs icon at the top.  

3. It is recommended that you set New pages should be opened in: 

a. If you are using dual monitors, select a new window. 

b. If you are using a single monitor, select a new tab.  You should also check When I 
open a link in a new tab, switch to it immediately. 

4. Click OK to save and exit.  All of the Tabs settings are described in the Firefox help system. 

Searching for Text 

In Firefox, CTRL-F can be used to search any window.  This is a great tool to use when searching 
for a field in the Patient Set Editor or when searching for text in a popup window.   

1. Press CTRL-F 

2. Enter the search text in the bottom part of the window.  The first occurrence of the text will 
be highlighted. 

3. Click Find Next to go to the next occurrence of the search string or click Highlight All to see 
all matches. 

Browser Navigation Settings 

The following diagram shows SEER*DMS in a window that includes the browser’s navigation 
controls.  The browser menus appear under “Home - Mozilla Firefox” at the top of the page.  
Navigation buttons (Back, Forward, Reload, Stop, and Home) and the address box are shown just 
under the menus. 

 

You should not use the browser’s navigation buttons to change pages in SEER*DMS.   It is 
recommended that you hide the browser icons to provide additional space for SEER*DMS and to 
avoid using the buttons inadvertently.    These buttons change your page view, but SEER*DMS 
does not recognize these commands and your work will not be saved. 
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On the View menu in Firefox, 
select Toolbars.  To show or hide a 
toolbar, simply click its menu item. 
 
Make sure that both the Navigation 
Toolbar and Bookmarks Toolbar 
are not checked.  

Display Recommendations 

SEER*DMS requires a minimum resolution of 1024x768.  However, a higher resolution is 
recommended if possible.  However, a higher resolution is recommended if possible.  SEER*DMS 
auto-detects the resolution.  If the resolution is 1600 or greater in width, a second panel of data 
will be shown on the right side of the Record and Patient Set editors.  You may view text or a list of 
failing edits while viewing other data in the left part of the screen.  If the resolution is less than 
1600 in width, the user will need to open the text in a separate window and view edits on a 
separate page.  Using a resolution greater than the minimum will also reduce the scrolling while 
editing.   

The browser’s default or “normal” text size should be used.   Images, buttons, and text may be 
misaligned if the Text Size is increased.    

 

 

 
To set the text to the normal size 
in Firefox, select Zoom from the 
Firefox View menu.  Click Reset. 
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Recommended Firefox Options 

As is true of most Web browsers, Firefox “remembers” passwords and information entered into a 
form in order to provide suggestions when completing similar forms in the future.  For increased 
security of the confidential patient data in SEER*DMS, you should disable the option to save 
passwords.  To avoid entering one patient’s data into another patient’s form, you should disable 
the browser options to remember information previously saved in forms.  Recommendations for 
options related to new pages were discussed in the Viewing Two Pages at Once section of this 
chapter (the instructions are included here to enable you to set all Firefox options at one time).  

To set the Firefox options as recommended for SEER*DMS: 

1. From the Firefox Tools menu, select Options. 

2. Tabbed browsing allows you to display multiple SEER*DMS pages within a single window.  
However, dual monitor configurations would benefit from displaying multiple pages in 
separate windows.  Click the Tabs icon at the top. 

a. It is recommended that you set New pages should be opened in: 

i. If you are using dual monitors, select a new window. 

ii. If you are using a single monitor, select a new tab.  You should also check When 
I open a link in a new tab, switch to it immediately. 

3. Pop-up windows are used to display the print preview for Records and Patient Sets.  To 
ensure that you can print data within SEER*DMS, click the Content icon at the top and set 
the option related to pop-up windows.  You can either: 

b. Uncheck Block pop-up windows 

c. Or add the address for SEER*DMS as an exception when you configure Firefox. 

d. Or attempt to print a Record or Patient Set.  Firefox will inform you that pop-ups are 
blocked.  Firefox will ask if you would like to add the SEER*DMS address to the list of 
sites for which pop-ups will be allowed.   

2. SEER*DMS uses Javascript to display some popup windows.   To ensure that the Text, DX 
Info, and other popups are displayed when open: 

a. Click the Content icon at the top.   

i. Verify that Enable Javascript is checked. 

ii. Click the Advanced button for Enable Javascript.  Check the box that says 
Raise or Lower Windows and click OK. 

4. Click the Privacy icon at the top.  In the History section, uncheck Remember what I enter 
in forms and the search bar. 

5. Click the Security icon and uncheck the Remember passwords for sites box. 

6. Click OK to save changes. 
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Using the SEER*DMS Test Server 

There are two versions of SEER*DMS available at your registry.  The production or “live” version of 
SEER*DMS accesses the registry’s true database.  A second application and database are available 
for testing and training.  The SEER*DMS test server data is updated on an ad hoc basis by registry 
IT staff.   Changes made on the test server will be lost when the database is reloaded.   A banner is 
displayed at the top of the page after you login to be sure that you do not use the test server by 
mistake.   If you do login to the test server by mistake, clear your browsing history and check all 
Firefox bookmarks and shortcuts. 
 

 


